microEnable 5 ironman

CoaXPress & Camera Link

Runtime Version 5.4.1 or higher

Getting Started
Contents

1 How to Use This Book ........................................................................................................5
2 Getting the Frame Grabber Ready ..................................................................................6
  2.1 Installing the Hardware ...............................................................................................6
  2.2 Installing the Runtime Software under Windows .......................................................8
  2.3 Installing the Runtime Software under Linux ............................................................10
  2.4 Firmware ..................................................................................................................10
3 Getting the Camera Ready ..............................................................................................11
  3.1 Connecting the Camera Physically ............................................................................11
  3.2 Configuring the Camera ............................................................................................13
    3.2.1 Autodiscovery (CoaXPress Only) ......................................................................13
    3.2.2 Configuring the Camera (CoaXPress only) .......................................................16
4 Image Acquisition with the Tool microDisplay ..........................................................18
  4.1 Starting the Image Acquisition ..................................................................................18
  4.2 Using the Shading/FPN Correction Feature ...............................................................21
  4.3 Using SmartApplets 3D Laser Triangulation – Peak Detector ..................................23
5 Further Setup Options ....................................................................................................25
  5.1 Firmware Installation .................................................................................................25
    5.1.1 Checking Pre-Installed Firmware (microDisplay) ..............................................25
    5.1.2 Flashing the Frame Grabber ..............................................................................26
  5.2 Runtime & Applet Installation ....................................................................................35
    5.2.1 Minimized Download Size of Runtime Installer .................................................35
    5.2.2 Updating Acquisition Applets ............................................................................38
    5.2.3 Silent Installation Under Windows ....................................................................39
    5.2.4 Disabling FPGA Live Reconfiguration ..............................................................43
  5.3 CoaXPress Only: Camera and Topology Configuration ...........................................44
5.3.1 Adapting the Link Topology (GenICam Explorer) ................................................................. 44
5.3.2 Starting Link Topology Detection Manually ......................................................................... 47
5.3.3 Using an External XML File .................................................................................................. 49
5.3.4 Configuring the Program Behaviour of the GenICam Explorer at Program Start .......... 49
5.4 Resetting the Global Settings in microDisplay ........................................................................ 51
6 Image Acquisition using the Silicon Software SDK .................................................................... 52
7 Where to Find Further Documentation ....................................................................................... 53
8 Additional Applets and Patches ................................................................................................... 55
9 Support ......................................................................................................................................... 55
1 How to Use This Book

Image Acquisition – Quick Start
If you want to get started with your image acquisition as quickly as possible, just follow the step-by-step instructions of chapters 2 - 4.

Further Setup Options
Solutions for special tasks during setup are described in chapter 5. However, you will find links to the sections of chapter 5 in chapters 2 - 4 whenever relevant.

SDK
If you want to use the SDK, refer to chapter 6 which provides you with useful information on how to move on.
2 Getting the Frame Grabber Ready

2.1 Installing the Hardware

Requirements: Availability of physical PCIe 2.x (Gen2) x8 or x16 interface with at least 8 wired PCIe lanes to achieve the full performance of the board (refer your mainboard manual for detailed information).

Caution

Before installing hardware, ensure that

- the system power is OFF and unplugged from the power outlet,
- proper electrical grounding procedures have been followed.

To install the Frame Grabber Hardware:

1. Shut down your computer.
2. Unplug your computer from the power outlet.
3. Plug the microEnable frame grabber into a free PCIe 2.x (Gen2) x8 or x16 slot of your PC.

Powering the Frame Grabber

Frame grabbers of the microEnable 5 ironman family need an extra connection to the power supply.

4. Plug the 4pin Molex PC power supply connector into the frame grabber. If your PC doesn’t provide a 4pin power supply, use an according adapter.
5. Boot the system.
6. After booting, the frame grabber is recognized in the Windows Device Manager under Multifunction adapters.
7. There are two ways the frame grabber may be displayed under *Multifunction adapters*. If the frame grabber is displayed

- *as Unknown device*: Proceed as described in the next section *(2.2 Installing the Runtime Software)* to install runtime 5.4.x. The relevant driver will be installed together with the runtime.

- *with the model type description of the frame grabber:*
  - Make sure runtime 5.4.x is already installed on your system (otherwise, proceed with the next section *(2.2 Installing the Runtime Software)*).
  - Make sure the version of the frame grabber’s driver is the same as the one available in the installation folder of the runtime. If not, update the driver with the driver you find in the installation folder of the Silicon Software runtime 5.4.x.

---

**Caution**

Make sure you use an adequate ventilation system within your computer.

This is of special importance if

- there is little space between boards in a multi board installation,
- an installation is close to a graphics card.

We also recommend leaving enough free space between boards.

---

*Figure 1: Plugged frame grabber board within a PC*
2.2 Installing the Runtime Software under Windows

You can download the runtime installer file from the [download area on the Silicon Software website](#). The installer contains the runtime software, related tools, and all supported Acquisition Applets.

You can choose between two installers, depending on the operating system you are using (Windows 32 bit or Windows 64 bit):

- RuntimeSetup_with_Applets_v5.4.x.x_Win64.exe
- RuntimeSetup_with_Applets_v5.4.x.x_Win32.exe

Figure 2: Downloading the Runtime Installer

**Minimized Download Size**

If you prefer small download files, refer to section 5.2.1 and follow the download and installation steps described there.
Silent Installation

If you prefer silent installation, refer to section 5.2.3 Silent Installation Under Windows.

To install the Silicon Software runtime software:

1. Uninstall all Silicon Software runtimes prior to the version you are going to install.
2. Make sure you also delete all related subfolders in the Silicon Software installation folder.
3. Select/download the *.exe file that matches your operating system (Windows 64bit or Windows 32bit).
4. Start the installer RuntimeSetup_v5.4.x_Winxx_with_AppletSetups.exe.
5. Follow the instructions of the installation wizard. If you select Full Installation (see Figure 3), the runtime software, drivers, all tools, and the Acquisition Applets get installed on your system.

Figure 3: Installation Wizard with Default Option “Full installation”

Updating Applets

You can install new or enhanced sets of Acquisition Applets and use them within your already existing runtime installation. New applets or applet updates are provided in individual applet installers (*.exe files). How to update your applets, see section 5.2.2.
2.3 Installing the Runtime Software under Linux

For runtime installation under a Linux operating system, refer to our Installation Guide for installing the Silicon Software Runtime under Linux on the Silicon Software Live Documentation site.

2.4 Firmware

The microEnable 5 frame grabber is shipped with pre-installed firmware. This firmware is suitable for a first check of the overall system functionality.

When you start to adapt the system to your specific image acquisition requirements, you may need to install another firmware on your frame grabber.

The firmware corresponding with an applet comes together with the applet in one *.dll or *.hap file. Thus, for loading the firmware on your grabber, you first have to know which applet (i.e., which image acquisition and processing functions) you need.

Silicon Software provides a wide range of image acquisition and processing applets. If you need support in finding out which of our applets is the optimal one for your specific image acquisition system, please refer to our Applets Guide on the Silicon Software website.

Once you have made your decision, see section 5.1.2 Flashing the Frame Grabber to know how you get the firmware/applet onto the grabber.
3 Getting the Camera Ready

3.1 Connecting the Camera Physically

To connect your camera to the frame grabber:

1. Plug all cables of your camera into the connectors of the frame grabber.

Camera Link:

![Camera Link frame grabber ports](image)

Figure 4: Camera Link frame grabber ports

CoaXPress DIN Ports:

![CoaXPress DIN frame grabber ports](image)

Figure 5: DIN frame grabber ports
CoaXPress BNC Ports (discontinued models):

![Image of BNC frame grabber ports]

Figure 6: BNC frame grabber ports (as specified in CXP standard 1.0)

**Recommended Order of CXP Ports**

With CoaXPress cameras, we recommend you stick to the following order of ports:

- Connect camera port 1 to port CXP 1 of the frame grabber, and proceed accordingly, connecting
- camera port 2 to frame grabber port CXP 2,
- camera port 3 to frame grabber port CXP 3, and
- camera port 4 to frame grabber port CXP 4.

**Automatic Power Over yes/no Detection**

**Camera Link**: If you use a camera that provides Power Over functionality, this feature is detected by the frame grabber and the camera is powered via the Camera Link cable. If you use an externally powered camera, the frame grabber detects this feature and automatically disables its power supply via the Camera Link cable.

**CoaXPress**: CoaXPress always supports Power Over functionality.
3.2 Configuring the Camera

1. Configure the camera according to the needs of your project:
   a. If you use a CoaXPress camera, proceed as described in the following sub-sections 3.2.1 and 3.2.2.
   b. If you use a Camera Link camera, install the camera configuration tool which comes together with the camera. Configure the camera as recommended by the camera manufacturer and proceed with section 4 Image Acquisition with the Tool microDisplay.

<table>
<thead>
<tr>
<th>Camera Link Configuration Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>For specific information on the camera link configuration interface of the Silicon Software frame grabbers, see The Clser Interface and the documents Virtual COM Ports – Quick Start Guide and Using Virtual COM Ports.</td>
</tr>
</tbody>
</table>

3.2.1 Autodiscovery (CoaXPress Only)

The Silicon Software CoaXPress frame grabbers offer the GenICam interface and come together with a graphical tool for accessing this interface: the GenICam Explorer.

The tool GenICam Explorer comes as part of the runtime installation. The GenICam Explorer discovers connected cameras automatically and provides direct access to the GenICam interface of the camera.

Using the GenICam Explorer, you can

- configure and control the camera connection.
- configure the camera.

To connect the camera to the frame grabber:
1. Open the *GenICam Explorer* (Start -> All Programs -> Silicon Software -> Runtime x.x.x -> GenICam Explorer).

On program start:

- The start window of the *GenICam Explorer* opens.
- The *GenICam Explorer* starts the automatic camera discovery.
- The *GenICam Explorer* connects to the discovered camera.

### Important

You can define if you want the GenICam Explorer to take all this steps automatically. If you prefer user interaction, you can configure the program behavior, see section 5.3.4 Configuring the Program Behaviour of the GenICam Explorer at Program Start.

### Starting Full Discovery Manually

If the camera cannot be discovered on starting the GenICam Explorer, you can start the discovery manually, see section 5.3.2 Starting Link Topology Detection Manually.

You see the current status of the camera discovery and the connecting process in the task bar:

Figure 7: Taskbar of Program Window during automatic Camera Discovery and automatic Camera Connect
After successful camera discovery, information on the detected camera and link topology is displayed:

![Camera Information Display](image)

Figure 8: After automatic camera discovery, camera information is displayed

2. Use the right-hand scroll bar to get access to all information.

3. Check if the link topology meets your requirements. (If more than one cameras are connected, you can select the camera in the left bottom panel *Model UID*).

   - If the link topology meets your requirements, proceed as described in the next section *(3.2.2 Configuring the Camera (CoaXPress only)).*
   - If not, proceed as described in section *(5.3.1 Adapting the Link Topology (GenICam Explorer)).*
3.2.2 Configuring the Camera (CoaXPress only)

Prerequisites: The GenICam Explorer is started. On program start, the camera has been successfully discovered and connected.

Connecting the Camera Manually

If the camera is not connected yet, click the Quick Connect button.

Using External XML Files

If you want to use an external configuration file for setting the camera parameters, see section 5.3.3 Using an External XML File.

The parameters of the GenICam interface with current settings are displayed in the GenICam Explorer directly after connecting to the camera. You are ready to start the actual camera configuration.

To configure the camera:

1. Adapt the settings of the GenICam parameters to your needs.
   In the Value column, type in or select the new value.

2. Scroll down to access all parameters.

Figure 9: Changing parameter values under Value
To see your changes after modifying parameter values:

3. Click on the **Force Update** button. The display will be updated immediately.

<table>
<thead>
<tr>
<th>Writing Data Directly into the Camera</th>
</tr>
</thead>
<tbody>
<tr>
<td>During image acquisition, the camera will use the settings you define here, since you are writing the data directly into the camera. There is no need to load the XML file onto the camera.</td>
</tr>
</tbody>
</table>
4 Image Acquisition with the Tool microDisplay

4.1 Starting the Image Acquisition

To start the image acquisition:

1. Start the tool microDisplay either by
   - clicking on START -> All programs -> SiliconSoftware -> RT 5.4.x -> microDisplay
     (default setting)
   - or (CXP only) directly from the GenICam Explorer menu:

2. Load the appropriate applet into microDisplay. The applet is contained in the same *.dll (or *.hap) file as the firmware. To load the applet into microDisplay:
   a. In the start dialog I want to..., select Load Applet.
   b. In the dialog Load Hardware Applet, select the board (frame grabber) you want to use.
   c. One applet (supporting a certain camera) is highlighted. It corresponds to the firmware currently installed on the frame grabber.
   d. Select the highlighted applet and click on the load button:

   ![Figure 10: Load button in microDisplay](image)

   e. Close the Load Hardware Applet dialog.
3. Enter the corresponding values for image width and height in the parameter panel -> ROI:
   
a. Right-click directly on the value and select **Edit**.

b. Enter the value.

![Figure 11: Entering ROI parameters](image11.png)

4. Start image acquisition on the frame grabber by clicking on the button **Grab and display an infinite number of frames**.

![Figure 12: Starting image acquisition on the frame grabber](image12.png)

The grabbed images are now displayed in **microDisplay**:

![Figure 13: Display of grabbed images in the tool microDisplay](image13.png)
5. To stop the acquisition, click on the stop button in *microDisplay*:

![Figure 14: Stopping acquisition on the frame grabber via microDisplay](image)

**Test Acquisition with Pre-Installed Firmware**

Your frame grabber comes with a pre-installed firmware/applet. The pre-installed firmware/applet may not support the camera type and topology you are using. Nevertheless, in most cases it is suitable for a first system test. Just start image acquisition (step 4 above) for the available ports.

If the pre-installed firmware/applet supports the camera type and topology you are using, the according Port(s) are highlighted green in microDisplay.

**Loading the Firmware/Applet you need for your specific Image Acquisition/Processing**

If you need another firmware/applet than the highlighted one: Flash your frame grabber with the firmware/applet you need, see section 5.1.2 *Flashing the Frame Grabber*. Applet and corresponding firmware come in one *.dll or *.hap file.

Silicon Software provides a wide range of image acquisition and processing applets. If you need support in finding out which of our applets is the optimal one for your specific image acquisition system, please refer to our *Applets Guide* on the Silicon Software website.
4.2 Using the Shading/FPN\textsuperscript{1} Correction Feature

Details on how to use Shading/FPN Correction can be found in the according applet documentation.

In the following, you get a quick introduction on how to use offset correction.

**Generation of correction coefficients, pixel by pixel – Offset correction**

1. Start microDisplay and load the applet (see section \textbf{4.1 Starting the Image Acquisition}).
2. Set the camera to the desired exposure time.
3. Cover the sensor / the camera objective (no light should come on the sensor).
4. Record a black image by clicking the button as shown in the picture below.
5. Save the black image as a TIFF file to the hard drive.

---

\textsuperscript{1} Fixed Pattern Noise (FPN)
6. In the middle panel on the right hand side of the Program Window, go to **Black Image**:

   ![Black Image Panel](image)

7. Right-click on **Black Image** and load the black image you just created.

8. Set **Apply Settings** to **Apply** (via right click).

9. Set **Enable** to **On** (via right click).

   ![Enable Setting](image)

   **Figure 16:** Setting the parameters to enable offset correction

Now you can start acquisition. The image quality is improved by the Shading/FPN correction.

**Note**

In almost the same manner, gain correction can be configured and used.
4.3 Using SmartApplets 3D Laser Triangulation – Peak Detector

**Important**

SmartApplets 3D Laser Triangulation can only be used on V Series frame grabbers. The license is not covered in the standard delivery.

Details on how to use SmartApplets 3D Laser Triangulation (Peak Detector) can be found in the according applet documentation.

In the following you get a quick introduction on how to use it.

Take the following steps:

1. Start *microDisplay* and load the SmartApplets 3D Laser Triangulation (Peak Detector) applet.

2. Set the following parameters:
   - Camera (Image) Width,
   - (RoI) Width, and
   - (RoI) Height.

3. Select the image output you want to get.
   
   The parameter Image Output allows to control the output. There are three options available:
   - (1) *Laser Line and Image*,
   - (2) only *Laser Line*,
   - (3) only *Image*.
Figure 17: Setting parameters to enable 3D laser triangulation

4. Start the acquisition.
5 Further Setup Options

5.1 Firmware Installation

5.1.1 Checking Pre-Installed Firmware (microDisplay)

The microEnable5 frame grabber is shipped with pre-installed firmware. Nevertheless, you might need to change this firmware.

For each combination of camera interface with camera type, a specific applet with corresponding firmware has to be installed on the frame grabber. Thus, which firmware you need depends on the camera type and link topology you want to use. Applet and corresponding firmware come always in one *.dll or *.hap file.

<table>
<thead>
<tr>
<th>Self-explaining File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>The DLL file name gives you all information which interface and which camera are supported by the firmware:</td>
</tr>
<tr>
<td>1. Acq = acquisition applet</td>
</tr>
<tr>
<td>2. Single (CXP only) = the system works with 1 camera</td>
</tr>
<tr>
<td>3. Full (Camera Link only) = the system works with 1 camera</td>
</tr>
<tr>
<td>4. CXP6 (CXP only) = CXP6 interface standard is used (6 Gigabit per second)</td>
</tr>
<tr>
<td>5. x4 (CXP only) = number of lanes (4 lanes are used)</td>
</tr>
<tr>
<td>6. Information on the camera: line/area and color/gray</td>
</tr>
<tr>
<td>7. Last number before file name extension = Bit depth per pixel</td>
</tr>
</tbody>
</table>

To check which firmware/applet is pre-installed:

1. Start the tool microDisplay.

2. In the dialog I want to..., select Load Applet.

3. In the Load Hardware Applet dialog, select the board you want to get information about (left upper corner).

4. The currently available firmware/applet (supporting a certain camera) is highlighted.
5. Check if the highlighted firmware/applet supports the camera and topology you want to use. (The most relevant information is encrypted in the name of the *.dll / *.hap file, see above; see also our Applets Guide on the Silicon Software website to find the optimum applet for your specific image acquisition system.)

6. Make sure you get the relevant firmware on your frame grabber:
   - If the pre-installed firmware/applet supports the camera and topology you need, skip the next section and proceed with section 3 Getting the Camera Ready.
   - If the pre-installed firmware/applet does not support the camera and topology you need, follow the instructions in the following section 5.1.2 Flashing the Frame Grabber in order to install the firmware/applet you need on your grabber.

### 5.1.2 Flashing the Frame Grabber

#### Firmware Comes as Part of Applet File

The firmware for the microEnable 5 frame grabbers is packed into the *.dll files and/or *.hap files that also contain one applet.

#### Standard Applets

For each frame grabber model, one applet installer is available. An applet installer contains all standard applet files (*.dll files) that are available for a specific frame grabber model.

You need to run the applet installer (or the complete installer containing runtime and applets) on the host PC that houses the frame grabber board before you can flash the frame grabber board with a standard applet (*.dll file). (For installation instructions, see sections 2.2 and 2.3).
Standard Applets - continued

After installation, the applet files are available on your host PC and can be used for flashing the frame grabber board. For details on applet installers and applet update installation, see sections 5.2.1 Minimized Download Size and 5.2.2 Updating Acquisition Applets.

Individual Apples

Only Use *.HAPs out of ZIP Archives:

If you want to flash an individual applet (*.hap) from an external source, make sure this applet has come to you in a *.zip archive.

The applet has to be transferred from the VisualApplet developers machine safely protected in a *.zip file. Even on modern systems, copying files (that are not protected in an archive) via network, USB memory sticks, or by email is not safe and may result in corrupted files.

Flashing a corrupted *.hap file may cause your microEnable 5 ironman frame grabber to be unavailable for software. In this case, the frame grabber board has to be send in to Silicon Software.

To install a firmware/applet onto the frame grabber:

1. Close the tool microDisplay.
2. Start the tool microDiagnostics (e.g., via Windows Start -> All Programs).
3. Select the frame grabber you want to install the firmware on.

![Start window of microDiagnostics](image)

**Figure 18:** Start window of microDiagnostics

4. Click the button **Flash Board(s)**. The program leads you to a file selection dialog. The presented folder contains all firmware/applet files available on the host PC for your frame grabber model. (How to update the applet set on your host PC, see section [5.2.2 Updating Acquisition Applets](#).)
5. Select the firmware/applet you need. (The file name gives information which interface and which camera are supported by the firmware/applet, see above. See also our Applets Guide on the Silicon Software website.)

6. Click on Open and confirm by clicking on Yes.

The flashing process gets started now:

![Flashing in progress](image)

*Figure 20: Flashing in progress – as displayed in microDiagnostics*

---

**Keep Frame Grabber Powered**

If you experience any problems, keep the frame grabber powered and call the Silicon Software Support department.
7. Wait until the new firmware/applet is completely installed.

<table>
<thead>
<tr>
<th>Windows or Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following behaviour of the system depends on the operating system you use on the host PC.</td>
</tr>
<tr>
<td>- If you are using Windows, just follow the instructions below.</td>
</tr>
<tr>
<td>- If you are using Linux, the system will behave as described on page 34 (complete shutdown and restart required), since the FPGA live configuration has not been implemented for Linux.</td>
</tr>
</tbody>
</table>

With a host PC supporting live reconfiguration\(^2\) of the FPGA (see chipset lists below), with runtime version 5.4.1\(^3\) (or higher) installed on the host PC, and if the firmware/applet package installed on your frame grabber before flashing is of version 2.1 or higher, you get one of the following messages (A, B or C) after flashing:

---

\(^2\) FPGA live configuration is only available under Windows; FPGA live configuration can be disabled by user, see section 5.2.4.

\(^3\) You can use FPGA Live Configuration with runtime 5.4.0 and applets of version 2.1 if you add a new environment variable SISO_ENABLE_RECONFIGURATION=YES to the OS system of your host PC.
A) Restarting applications:

- Close all applications of the Silicon Software runtime environment (microDisplay, microDiagnostics, GenICam Explorer).

Now, the firmware/applet is successfully flashed onto the frame grabber. After re-opening, the runtime programs will provide access to the applet you just flashed onto the frame grabber. You can continue with configuring the applet via microDisplay (see section 4.1) or via SDK.

**PCs supporting Life Reconfiguration, Behavior A**

High-end mainboards with server level chipset support this behavior. The following chipsets are known to support FPGA live configuration without reboot in some mainboards:

- Intel® X58 Express
- Intel® X79 Express
- Intel® Z87 (Z99)

**Applets supporting Life Reconfiguration, Behavior A**

The applet installed on the frame grabber before flashing must be of applet version 2.1 or higher. The runtime installed on the host PC must be of version 5.4.1 or higher.

**We do not guarantee Behaviour A with the aforementioned chipsets under the aforementioned preconditions.**

---

4 You can use FPGA Live Configuration with runtime 5.4.0 and applets of version 2.1 if you add a new environment variable SISO_ENABLE_RECONFIGURATION=YES to the OS system of your host PC.
B) Optionally rebooting host PC:

You will get this message if your frame grabber has been flashed successfully, but the PCI speed is reduced\(^5\) after flashing.

To get the full PCI bandwidth\(^6\), you need to reboot your host PC:

\[\rightarrow\] Reboot your host PC to get the full PCI bandwidth.

After re-boot, you get the full bandwidth on the PCI interface. The runtime programs will provide access to the applet you just flashed onto your frame grabber. You can continue with configuring the applet via microDisplay (see section 4.1) or via SDK.

<table>
<thead>
<tr>
<th>PCs supporting Live Reconfiguration, Behavior B</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-end mainboards with server level chipset support this behavior. The following chipsets are known to support FPGA live configuration without reboot in some mainboards:</td>
</tr>
<tr>
<td>• Intel® X58 Express</td>
</tr>
<tr>
<td>• Intel® X79 Express</td>
</tr>
<tr>
<td>• Intel® Z87 (Z99)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Applets supporting Life Reconfiguration, Behavior B</th>
</tr>
</thead>
<tbody>
<tr>
<td>The applet installed on the frame grabber before flashing must be of applet version 2.1 or higher. The runtime installed on the host PC must be of version 5.4.1(^7) or higher.</td>
</tr>
</tbody>
</table>

\(^5\) PCI may be reduced from generation 2 to generation 1, or the link width changes (e.g., 8 to 4, 4 to 1, ...).

\(^6\) Reboot not always required: If you intentionally flashed an applet that reduces the PCI speed (in comparison to the applet that has been on marathon before flashing), you do not need to reboot your host PC.
We do not guarantee Behaviour A with the aforementioned chipsets under the aforementioned preconditions.

C) Rebooting host PC:

<table>
<thead>
<tr>
<th>PCs Requiring Reboot, Behaviour C</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following chipsets are known to require a reboot after FPGA configuration:</td>
</tr>
<tr>
<td>• Intel® C220</td>
</tr>
<tr>
<td>• Intel® H87</td>
</tr>
<tr>
<td>In addition, the applet installed on the frame grabber before flashing must be of applet version 2.1 or higher, and the runtime version installed on the host PC must be version 5.4.1 or higher.</td>
</tr>
</tbody>
</table>

---

Message

Board flashed successfully. You must reboot your computer for the changes to take effect.

a. Reboot your host PC.

Now, the firmware/applet is successfully flashed onto your frame grabber. After reboot, the runtime programs will provide access to the applet you just flashed onto the frame grabber together with the firmware. You can continue with configuring the applet via microDisplay (see section 4.1) or via SDK.

---

7 You can use FPGA Live Configuration with runtime 5.4.0 and applets of version 2.1 if you add a new environment variable SISO_ENABLE_RECONFIGURATION=YES to the OS system of your host PC.

8 You can use FPGA Live Configuration with runtime 5.4.0 and applets of version 2.1 if you add a new environment variable SISO_ENABLE_RECONFIGURATION=YES to the OS system of your host PC.
Power Cycling Required

Whenever the applet installed on the frame grabber before flashing is of version 2.0 or older, or if you use a runtime software on the host PC of version 5.3.4 or older, you need to power cycle your host PC after flashing.

Working with runtime version 5.4.1 or higher, and after flashing your frame grabber once with an applet of version 2.1 or higher, you will probably never be asked for power cycling again. All applets version 2.1 and higher of Silicon Software support FPGA live reconfiguration (behavior A, B or C) after flashing.

Linux – Behaviour after Flashing

Under Linux, after each flashing, you will be prompted to power cycle (cold-boot) your host PC:

To power cycle your host PC:

1. Click **Shut Down** to shut down your host PC completely (the Restart option is not enough).

2. After the computer is completely off, wait for some seconds.

3. Start the host PC again.

Complete Shut Down Essential

For power cycling, it is not enough to use the **Restart** option. Complete shut down and following new start are essential when you need to power cycle your host PC.

---

9 You can use FPGA Live Configuration with runtime 5.4.0 and applets of version 2.1 if you add a new environment variable SISO_ENABLE_RECONFIGURATION=YES to the OS system of your host PC.

10 You can use FPGA Live Configuration with runtime 5.4.0 and applets of version 2.1 if you add a new environment variable SISO_ENABLE_RECONFIGURATION=YES to the OS system of your host PC.
5.2 Runtime & Applet Installation

5.2.1 Minimized Download Size of Runtime Installer

You have different possibilities for installing the runtime software and the applets you need. Which way you choose depends the download possibilities you have.

If you need to minimize the size of your download packages:

1. Uninstall all Silicon Software runtimes prior to the version you are going to install.
2. Make sure you also delete all related subfolders in the Silicon Software installation folder.
3. Download the runtime software installer that installs the runtime software, drivers, and tools, but no applets from the download area on the Silicon Software website (under Download Overview/Software Installations/Runtime Installations). The installer file has, depending on the operating system you are using, the following name:

   RuntimeSetup_v5.4.x.x_Win64.exe
   RuntimeSetup_v5.4.x.x_Win32.exe.

Figure 21: Downloading Frame Grabber-Specific Applet Set
4. Select/download the *.exe file that matches your operating system – Windows 64bit or Windows 32bit.

5. Start the installer RuntimeSetup_v5.4.x_Winxx.exe.

6. Follow the instructions of the installation wizard.

After you have successfully installed the runtime software:

7. Download the applet installer that contains the applets (and firmware) for your specific frame grabber model. You can download the individual applet installers *.exe from the download area on the Silicon Software website.

8. Start the installer *.exe.

9. Follow the instructions of the installation wizard.

10. Under Select Components, select Full installation or select the individual applets you are going to use:

11. Follow the instructions of the installation wizard until the installation is completed.

Runtime Installation required
You can install new or enhanced sets of Acquisition Applets and use them within your already existing runtime installation. New applets or applet updates are provided in
form of individual applet installers (*.exe files).

Make sure you have already installed the runtime before you start your applet installation (minimum version 5.3.400; recommended as of January 2016: runtime version 5.4.1 or higher).

If the runtime is not installed yet, install the runtime first. The runtime installer is available on the Download area of the Silicon Software website.

---

**Updating Applets**

How to flash new applets to your frame grabber, see section 5.1.2.

The following applet installers are available for microEnable 5 frame grabbers (as of January 2016):

**Windows 64 bit:**

- AppletsSetup_mE5_AQ8-CXP6D_[version of applet installer]_Win64.exe
- AppletsSetup_mE5_VQ8-CXP6D_[version of applet installer]_Win64.exe
- AppletsSetup_mE5_AQ8-CXP6B_[version of applet installer]_Win64.exe
- AppletsSetup_mE5_VQ8-CXP6B_[version of applet installer]_Win64.exe
- AppletsSetup_mE5_AD8-PoCL_[version of applet installer]_Win64.exe
- AppletsSetup_mE5_VD8-PoCL_[version of applet installer]_Win64.exe

**Windows 32 bit:**

- AppletsSetup_mE5_AQ8-CXP6D_[version of applet installer]_Win32.exe
- AppletsSetup_mE5_VQ8-CXP6D_[version of applet installer]_Win32.exe
- AppletsSetup_mE5_AQ8-CXP6B_[version of applet installer]_Win32.exe
- AppletsSetup_mE5_VQ8-CXP6B_[version of applet installer]_Win32.exe
- AppletsSetup_mE5_AD8-PoCL_[version of applet installer]_Win32.exe
- AppletsSetup_mE5_VD8-PoCL_[version of applet installer]_Win32.exe
5.2.2 Updating Acquisition Applets

You can use the applet installers available on the download area of the Silicon Software website to update the applets already installed on your system (if a newer version of an applet installer has been released).

You do not need to change your runtime installation when updating your applets.

<table>
<thead>
<tr>
<th>Preconditions for Updating Applets</th>
</tr>
</thead>
<tbody>
<tr>
<td>The runtime software has to be installed on your system (minimum version 5.3.400; recommended as of January 2016: runtime version 5.4.1 or higher).</td>
</tr>
</tbody>
</table>

To update your Acquisition Applets:

1. Check which frame grabber model and operating system you are using.
2. Select the according applet installer.
3. Make sure you have already installed the runtime software before you start your applet update. If the runtime software is not installed yet, install the runtime software first.
4. Start the selected applet installer. All applets contained, together with a detailed documentation on each applet, are copied into your runtime folder.

<table>
<thead>
<tr>
<th>Overwriting</th>
</tr>
</thead>
<tbody>
<tr>
<td>All components of the Acquisition Applets installation you are updating are overwritten with the components of the new Acquisition Applets installer version.</td>
</tr>
</tbody>
</table>

Overwritten are:

- The applets.
- The firmware *.dll files for flashing the frame grabber.
- All according applet documentation.
5.2.3 Silent Installation Under Windows

The Runtime installer supports silent installation. The setup program accepts optional command line parameters. These can be useful for system administrators and other programs calling the setup program.

Setup Command Line Parameters

/SILENT, /VERYSILENT
Instructs the setup to be silent or very silent.

- Silent setup: The wizard and the background window are not displayed, but the installation progress window is visible on screen.
- Very silent setup: Wizard and background window are not displayed; even the installation progress window is not displayed.

Everything else is normal, e.g., error messages during installation are displayed, as well as the startup prompt (if you haven't disabled it with DisableStartupPrompt or the '/SP-' command line option).

If a restart is necessary and the '/NORESTART' command isn't used (see below):

- Silent setup: A “Reboot now?” message box is displayed.
- Very silent setup: The system reboots without asking.

/SUPPRESSMSGBOXES
Instructs the setup to suppress message boxes. This command line parameter has only an effect when combined with with '/SILENT' or '/VERYSILENT'.

The used defaults are the following:

- 'Keep newer file?' Yes
- 'File exists, confirm overwrite.' No
- Abort/Retry: Abort
- Retry/Cancel: Cancel
- DiskSpaceWarning/DirExists/DirDoesntExist/NoUninstallWarning/ExitSetupMessage/ConfirmUninstall: Yes (=continue)
- FinishedRestartMessage/UninstalledAndNeedsRestart: Yes (=restart)
5 message boxes are not suppressible:

- The “About Setup” message box,
- The “Exit Setup?” message box, and
- The “FileNotInDir2” message box which is displayed when setup requires a new disk to be inserted and the disk was not found.
- Any (error) message box displayed before Setup (or Uninstall) could read the command line parameters.
- Any message box displayed by [Code] support function MsgBox.

/LOG="filename"
Same as /LOG, except that this parameter allows you to specify a fixed path/filename to use for the log file. If a file with the specified name already exists, it will be overwritten. If the file cannot be created, setup will abort with an error message.

/NORESTART
Instructs setup not to reboot even if a reboot is necessary.

/DIR="x:\dirname"
Overrides the default directory name displayed on the Select Destination Location wizard page. A fully qualified pathname must be specified.

/GROUP="folder name"
Overrides the default folder name displayed on the Select Start Menu Folder wizard page. If the [Setup] section directive DisableProgramGroupPage was set to yes, this command line parameter is ignored.

/NOICONS
Instructs setup to initially check the Don’t create a Start Menu Folder check box on the Select Start Menu Folder wizard page.

/COMPONENTS="comma separated list of component names"
Overrides the default component settings. Using this command line parameter causes the setup to automatically select a custom type. If no custom type is defined, this parameter is ignored.

Only the specified components will be selected; the rest will be deselected. If a component name is prefixed with a "*" character, any child components will be selected as well (except for those
that include the `dontinheritcheck` flag). If a component name is prefixed with a "!" character, the component will be deselected.

This parameter does not change the state of components that include the `fixed` flag.

**Usage:**

```<SISO_INSTALLER_EXE.exe> /Components = "<component1>,<component2>"```

**Available components:**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>core</td>
<td>Installation of core components (required)</td>
</tr>
<tr>
<td>tools_cli</td>
<td>Installation of command line tools</td>
</tr>
<tr>
<td>tools_gui</td>
<td>Installation of GUI tools</td>
</tr>
<tr>
<td>doc</td>
<td>Installation of documentation</td>
</tr>
<tr>
<td>gige</td>
<td>Support for GigE Vision frame grabber</td>
</tr>
<tr>
<td>dev\core</td>
<td>Installation of libs and header files</td>
</tr>
<tr>
<td>dev\examples</td>
<td>Installation of SDK examples</td>
</tr>
<tr>
<td>dev\examples_source</td>
<td>Installation of the source code of the examples</td>
</tr>
<tr>
<td>dev\examples_bin</td>
<td>Installation of example binaries</td>
</tr>
<tr>
<td>dev\cmake</td>
<td>Installation of cmake files</td>
</tr>
<tr>
<td>acq_applets</td>
<td>Installation of AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me4as1cl</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me4ad1cl</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me4ad4cl</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me4aq4ge</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me4vd1cl</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me4vd4cl</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me4vq4ge</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me5aq8cxp</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me5aq8cxp6d</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me5vq8cxp</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me5vq8cxp6d</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>acq_applets\me5ad8cl</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
</tbody>
</table>
### Component Description

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>acq_applets\me5vd8cl</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>advanced_acq_applets</td>
<td>Installation of Advanced AcquisitionApplets</td>
</tr>
<tr>
<td>advanced_acq_applets\acq me4aq4ge</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>advanced_acq_applets\acq me4vq4ge</td>
<td>Installation of frame grabber specific AcquisitionApplets</td>
</tr>
<tr>
<td>advanced_acq_applets\acq me4ad4cl</td>
<td>Installation of frame grabber specific Advanced AcquisitionApplets</td>
</tr>
<tr>
<td>advanced_acq_applets\acq me4vd4cl</td>
<td>Installation of frame grabber specific Advanced AcquisitionApplets</td>
</tr>
<tr>
<td>UpdateEnvironment</td>
<td>Update of the environment variables</td>
</tr>
<tr>
<td>CompCLStandardVersion_2</td>
<td>Installation of CLser as defined in Camera Link 2.0</td>
</tr>
<tr>
<td>Com_0_Com</td>
<td>Installation of virtual null modem</td>
</tr>
<tr>
<td>bin_libs</td>
<td>Installation of libs into the system directory</td>
</tr>
<tr>
<td>redist_package</td>
<td>Installation of redistributable packages</td>
</tr>
</tbody>
</table>

**Notes:**

- Multiple components are applied by a commata separated list.
- The list may not contain any blanks.

**/TASKS=“comma separated list of task names”**

Specifies a list of tasks that should be initially selected.

Only the specified tasks will be selected; the rest will be deselected. Use the /MERGETASKS parameter instead if you want to keep the default set of tasks and only select/deselect some of them.

If a task name is prefixed with a "*" character, any child tasks will be selected as well (except for those that include the dontinheritcheck flag). If a task name is prefixed with a "!" character, the task will be deselected.

**Usage:**

```
<SISO_INSTALLER_EXE.exe> /Tasks = "<task1>,<task2>"
```
Available tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>taskDesktopIcon</td>
<td>installs a desktop icon</td>
</tr>
<tr>
<td>taskDrvInstall64</td>
<td>update of the device drivers</td>
</tr>
</tbody>
</table>

Example for a silent installation:

```
RuntimeSetup_v5.2.2_Win64.exe
/components=core,tools_cli,acq_applets\me4ad1cl,acq_applets\me4vd1
cl /silent
```

5.2.4 Disabling FPGA Live Reconfiguration

Under Windows, you can always disable the live reconfiguration of the FPGA. After disabling this feature, you will need to power cycle (cold-boot) your host PC after flashing the frame grabber board. Under Linux, live reconfiguration of the FPGA is not available.

To disable the live reconfiguration of the FPGA:

1. Add the following system environment variable to your system:
   
   SISO_ENABLE_RECONFIGURATION

2. Set it to “NO”: SISO_ENABLE_RECONFIGURATION=NO

After each flashing, you will now be prompted to power cycle (cold-boot) your host PC:

```
Board flashed successfully. You must power cycle your computer for the changes to take effect.
```

To power cycle your host PC:

4. Click **Shut Down** to shut down your host PC completely (the Restart option is not enough).

5. After the computer is completely off, wait for some seconds.

6. Start the host PC again.
Complete Shut Down Essential

For power cycling, it is not enough to use the Restart option. Complete shut down and following new start are essential when you need to power cycle your host PC.

5.3 CoaXPress Only: Camera and Topology Configuration

5.3.1 Adapting the Link Topology (GenICam Explorer)

To adapt the link topology to your needs:

1. Open the GenICam Explorer.

2. On the Tools menu, select **Hardware Setup**.

3. In the window that opens, select the frame grabber you are working with.

4. Go to the tab **Link Configuration**.
The current link topology is displayed:

![Link Topology](image)

**Note**

If the current link topology cannot be detected, or if you changed the cable connection(s), see section 5.3.2 **Starting Link Topology Detection Manually**.

When the link topology is discovered:

5. Click on the **Edit** button.
Now, the parameters are editable:

6. Adapt the parameter settings to your needs.

7. Confirm by clicking the Apply button.

Loading and Saving Configurations

Each configuration can be saved to a file by clicking the Save Configuration… button. You can also load configurations available as file by clicking on the Load Configuration… button.

8. In the field Power Cycle / Waiting Time, enter the specific camera’s booting time, for example 50000 ms.

9. Close the Hardware Dialog window.
10. Verify the speed under *Link Configuration*: For CXP, e.g., 4 links @ **6.250 Gbps** should be available.

![Link speed for maximal use of CoaXPress](image)

Figure 22: Link speed for maximal use of CoaXPress

11. Proceed with the section [3.2.2 Configuring the Camera (CoaXPress only)](#).

### 5.3.2 Starting Link Topology Detection Manually

If the current link topology cannot be detected, or after you changed cable connections, one of the following two situations will appear. Proceed as described below to discover the camera and the link topology.

a) The following dialog appears. In this case, simply click on **Start Full Discovery**.
b) There is no dialog.

In this case, to discover the current link topology:

1. Open the GenICam Explorer.
3. In the left upper corner, select the frame grabber you are working with.
4. Go to the Link Configuration tab.
5. Click on Restart Layout Discovery.

6. Wait until the process is finished. You get an according message:

   The current link topology is displayed now.

7. Continue with adapting the link topology as described in section 5.3.1 “When the link topology is discovered …”.
5.3.3 Using an External XML File

Alternatively, you can also use an external XML file to configure the camera. In this case, you load the XML file from your file system and not from the camera.

To load an external XML file into the GenICam Explorer and on the camera:

1. In the GenICam Explorer, go to the **Connection** tab.
2. Activate the radio button **User Supplied GenICam XML File**.
3. Select the GenICam XML file you want to use. (Use only files supplied by the camera vendor).
4. Click on **Connect**.

   ![Figure 23: Loading an external XML file](image)

   It might take some seconds to load the file. The parameters of the GenICam interface with current settings are displayed. You are ready to start the actual camera configuration.

5. Proceed with step 1 in section 3.2.2 Configuring the Camera (CoaXPress only).

5.3.4 Configuring the Program Behaviour of the GenICam Explorer at Program Start

To configure the program behavior at program start:

1. In the **File** menu, select **Preferences**.
2. Select the options according to your needs:

If you want to go on with getting your camera ready, proceed with section 3.2.1 “You see the current status of the camera discovery ...“.
5.4 Resetting the Global Settings in microDisplay

To change microDisplay’s Settings Dialog:

1. Select **Tools -> Settings**.

![Global Settings Dialog in microDisplay](image)

2. Under **Standard Port Config**, change the following settings in order to allow image acquisition:
   a. Set **Acquisition timeout** to 100 s. This is the expected time gap between starting the image acquisition in microDisplay and the camera sending the first frame.
   b. Activate **Ignore Cam Clock Status**.
   c. Click the **OK** button.
6 Image Acquisition using the Silicon Software SDK

For detailed information on the Silicon Software SDK, please refer to the SDK documentation that comes with the runtime documentation:

Here, you will find all SDK documentation, including a general function reference as well as a CoaXPress specific and a Camera Link specific function reference.

Silicon Software also provides a set of SDK examples which comes together with the SDK documentation.
Where to Find Further Documentation

Silicon Software provides deep and comprehensive documentation for its frame grabber series.

The documentation is part of the installation package. After installation of the runtime software package, you find the documentation in the Windows start menu.

Where to find the Documentation

START -> All Programs -> SiliconSoftware -> Runtime 5.4.x -> Documentation

The most relevant information for running your frame grabber for the first time is:

Product Documentation Site

Welcome

Dear Customer,

The Silicon Software Documentation is intended to provide deep and complete information about the Silicon Software frame grabber products - from installation to usage. It covers the frame grabber series microEnable 5 CoaXPress, microEnable 5 Camera Link, microEnable IV Camera Link, microEnable IV GigE Vision, and microEnable IV UVC, as well as all add-ons [more].

Figure 26: Documentation set for Frame Grabbers & Runtime
You get the following information:

1) Introduction and Installation
   Quick start Guides for microEnable IV and microEnable 5 frame grabbers, containing all information you need to get your system running:
   - Installation of hardware and runtime software
   - All steps required to start image acquisition
   - Applets guide that makes it easy to find the optimal applet for your specific image acquisition system

2) Image Acquisition
   Information on
   - How frame grabber applets work
   - Which applets (supporting specific image acquisition and processing functions) are available for individual frame grabber models
   - How to set up an image acquisition
   - Trigger boards and how to use them

3) Frame Grabber Hardware
   Information on
   - Individual frame grabber boards and accessories

4) Software Development Kit (API)
   - Introduction to this powerful image acquisition library
   - SDK Manual
   - SDK Reference
   - SDK examples as a quick and simple starting point for your own C/C++ projects

5) Tools
   Information on
   - Camera configuration with *GenICam Explorer*
   - Image acquisition with *microDisplay*
   - Functionality of *microDiagnostics*
8 Additional Applets and Patches

Our products are under continuous development. New applets, providing advanced new features, are constantly added to our portfolio to meet the needs of our customers.

As the microEnable 5 frame grabber family is constantly improved and enhanced, there are also some patches available.

If you want to get information on new applets and patches in advance, or if you want to get these enhancements prior to the next release, feel free to contact our Silicon Software support team.

9 Support

For technical support please contact our support team:

mailto:support@silicon-software.de

Phone: +49 621 789 50 70
Contact Details

SiliconSoftware GmbH
Steubenstrasse 46
D - 68163 Mannheim, Germany
Phone: +49(0)621.789 507 0
Fax: +49(0)621.789 507 10
Email: info@silicon.software
Web: www.silicon.software

SiliconSoftware Inc.
1 Tara Boulevard, Suite 200
Nashua, NH 03062, USA
Phone: +1 603 324 7172
Fax: +1 603 324 7101
Email: info@silicon.software
Web: www.silicon.software

Disclaimer
While every precaution has been taken in the preparation of this manual, Silicon Software GmbH assumes no responsibility for errors or omissions. Silicon Software GmbH reserves the right to change the specification of the product described within this manual and the manual itself at any time without notice and without obligation of Silicon Software GmbH to notify any person of such revisions or changes.

Trademarks
All trademarks and registered trademarks are the property of their respective owners.

Copyright Note
© Copyright 2016 Silicon Software GmbH. All rights reserved. This document may not in whole or in part, be reproduced, transmitted, transcribed, stored in any electronic medium or machine readable form, or translated into any language or computer language without the prior written consent of Silicon Software GmbH.